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Disclaimer

SP TimeSavers, FrameMaker Edition, are licensed to you on an “as is” basis. MicroType makes 
no representation with respect to the adequacy for any particular purpose or to produce any particular 
result.

In no event will MicroType be liable to you for any loss or damage arising from the use of SP TimeSavers, 
FrameMaker Edition, including consequential or incidental damages, lost profits, lost savings, etc.

The current version of SP TimeSavers, FrameMaker Edition, is tuned to and tested with PostScript files 
generated by Adobe FrameMaker versions 5.0-6.0, and works with Acrobat 4.0x/Acrobat 5.0x.

It is possible that major new releases of FrameMaker will generate the PostScript output differently. 
In such a case, necessary adjustments will be made to maintain the present functionality whenever 
applicable.

PostScript, Acrobat and FrameMaker are registered trademarks of Adobe Systems Inc.
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Introduction

MicroType’s SP TimeSavers, FrameMaker Edition (formerly marketed as FrameMaker-to-Acrobat 
TimeSavers) is an integrated set of platform-independent utilities which control and/or enhance various 
aspects of the conversion from FrameMaker (5.x-6.0) to Acrobat 4 and 5. These utilities are designed 
for users of FrameMaker who create and maintain high-quality, interactive PDF files. SP TimeSavers 
enables you to define Acrobat features in your source FrameMaker files, so that they are automatically 
and consistently reproduced in the PDF, when the source is updated. This circumvents the tedious and 
repetitive use of Acrobat to set or adjust these features.

SP TimeSavers settings can be controlled through a Configuration Panel (see below). Specific settings 
can also be embedded in FrameMaker files using hypertext markers. 

Note: The SP TimeSavers Configuration Panel is based on an Acrobat form and requires Acrobat in order to 
save settings. If you only have Distiller and Acrobat Reader, but not the full version of Acrobat, all settings can 
be specified through the TS-set.ini file.

SP TimeSavers/FM 3.1 Configuration Panel
©2001 Shlomo Perets, MicroType
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What does SP TimeSavers Include?

Bookmark Controller

The following bookmark-related functions help make your bookmarks neater and easier to identify:

CollapseBookmarks automatically collapses Acrobat bookmarks, making your bookmark structure 
easier to understand, more readable on small screens and faster to load in Acrobat Reader. With 
SP TimeSavers, you can choose to collapse to the first or second hierarchical level.

ParaNumOut automatically removes the paragraph numbers from bookmarks (carried over from 
FrameMaker’s autonumbers). The resulting bookmarks are more suitable to an interactive screen format, 
and allow more space for meaningful text.

MergeBookmarks merges a bookmark, such as a chapter number, with the following one.

ExtractFigureBookmarks and ExtractTableBookmarks collate bookmarks for figures and tables and 
place them either at the beginning or the end of the bookmark list, under a corresponding heading, 
initially expanded or collapsed as needed.

FixSpecialCharsInBmk handles various special spaces and hyphens in bookmark text, so that they are 
meaningfully displayed.

ReOrderCustomBookmarks will force your custom bookmarks to be at the top or bottom of the 
list of bookmarks.

BookmarkStylerByText and BookmarkStylerByLevel enable you to define bookmark color and font 
properties (Acrobat 5) so that they are automatically created in the PDF, based on bookmark text and/or 
level.

ChangeBmkStart enables you to specify up to ten from-to replacements, so that repetitive text can 
be reduced to a shorter form (or eliminated entirely). For example, instead of “Appendix A: Technical 
Specifications”, the bookmark will be “App A: Technical Specifications”, with more space left for 
meaningful text.

RemoveRedundantBmkStart enables you to specify up to ten strings of redundant text that will be 
removed from the beginning of the bookmark, so that bookmarks will have a unique beginning and be 
easier to identify.

Link Controller

Link Controller enables you to globally control the way FrameMaker links are displayed, printed, 
or function in Acrobat, by using the following:

VisLinks controls highlighting style, border color and width. You can also automatically adjust the link 
area’s size. Visible links can be useful either in diagnostic versions or in the distribution PDFs. Internal and 
external links can be colored differently. If VisLinksPrint is activated, link borders will be printed when 
the PDF is printed.

ForceNewWindow automatically displays each externally-linked PDF file in a separate window, 
overriding the Acrobat Reader local preference of “open cross-document links in the same window”.

ChangeFileNameCase translates all file names used in FrameMaker links to lower case or to caps, which 
may be useful when developing interactive PDFs for platforms where file names are case-sensitive.
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FM Controls

PDFmarker enables the use of regular FrameMaker markers to specify PDF features in your FrameMaker 
file (thus avoiding the limitations of using text frames tagged as PostScript Code for this purpose). 

Common pdfmark commands or fragments thereof are easily accessible as pre-defined shortcuts, 
supplied with SP TimeSavers.

Using PDFmarker, you can:

inherit FrameMaker’s hypertext marker active area within your regular text flow – this is important 
for buttons, pop-ups and notes (with control over title, color and size)

anchor location-sensitive pdfmark commands to the appropriate location

insert many useful pdfmark commands which are not location-sensitive, hiding the “noise” of the 
code

insert setdistillerparams commands

specify a job-specific epilogue file to be processed in conjunction with your file

take advantage of pre-defined shortcuts (which you can use as is or customize for your needs). 

PDFmarker supports references to external files, which is useful when you need to reference similar sets 
of commands in different files, or as a way to overcome the FrameMaker limit of 255-characters in marker 
text.

ConvertFMnewlink makes it easy to use FrameMaker’s newlink marker to create “clean” named 
destinations used by external applications to access a specific location in the PDF file.

IgnoreDOCINFO, IgnoreDOCVIEW and IgnorePAGE enable you to suppress specific pdfmark 
commands issued by FrameMaker, which otherwise gain precedence over your own commands. (There 
are specific options depending on the FrameMaker release used).

ManageArticle enables you to convert each “Flow A” text frame into a separate, single-bead article 
thread – a useful setting in some page-based catalogs.

UnBloat removes redundant named destinations written by FrameMaker for each and every paragraph, 
typically reducing the PDF file size by 15% to 25%, depending on the contents and original size. In 
complex publications, with many multi-cell tables and multiple columns, size reduction is much higher. 
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Installing SP TimeSavers

Installing the SP TimeSavers for use with Acrobat 4.0x/5.0x (platform-independent)

Note: If you were using an earlier version of the TimeSavers, move all relevant files to another location 
before proceeding.

1 Unzip the SP TimeSavers distribution ZIP file to a temporary folder. The following files will be created:

2 Locate the folder where Acrobat Distiller is installed, and create a new folder named TimeSavers 
under the Distiller folder. (The folder name is not case-sensitive, however misspelling will cause 
an undefinedfilename error when trying to distill with SP TimeSavers activated).

3 Move the prologue.ps, epilogue.ps files from your temporary folder to the Distiller/Data folder.

4 Move all remaining files from your temporary folder to the Distiller/TimeSavers folder. 

5 If not already started, run Acrobat Distiller.

The software is to be installed in a single location on the hard disk of a single computer. SP TimeSavers 
are licensed for a single user. Additional installations require additional licenses, volume discounts 
are available.

You may make a backup copy of the software, provided your backup copy is not installed or used on 
any other computer.

File Function

readme.txt Release notes – read this file before proceeding

SPTS-FM.pdf TimeSavers manual (this file)

TS-set.pdf TimeSavers configuration panel

TS-set.fdf Form data exported from the configuration panel

TS-set.ini TimeSavers settings file

TS-prolog.ini TimeSavers prologue file

TS-epilog.ini TimeSavers epilogue file

TS-short.ini TimeSavers shortcuts

prologue.ps TimeSavers program file

epilogue.ps TimeSavers program file

calibrate.fm A test file to validate that the resolution setting in your printer driver
and in the TS-set.ini file match

FMAC.fm TimeSavers test file

FMACtest.pdf Expected results from test file when using FrameMaker 5.5.6 and later 
(some variations are possible when using earlier FrameMaker releases) 
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6 Click the Job Options drop-down list, and select a set of options you will use when distilling files with 
the TimeSavers (such as ScreenOptimized, PrintOptimized or eBook).

7 In the Settings menu, select Job Options. Select the Advanced tab, and turn on the Use Prologue.ps 
and Epilogue.ps option.

8 If you plan to include setdistillerparams commands in FrameMaker through hypertext markers, 
activate the Allow PostScript file to Override Job Options setting (Job Options > Advanced).

9 Click Save As to create a TimeSavers set of job options (based on the job options you started with, 
together with the Use Prologue.ps and Epilogue.ps option).

10 Create additional sets of job options as needed, with the Use Prologue.ps and Epilogue.ps setting 
enabled. Label each set of options with a special prefix that will identify it with the TimeSavers 
(such as TimeSavers-eDocs, TimeSaversPrint).

All functions activated through the configuration panel (TS-set.pdf ) or the configuration file 
(TS-set.ini) will be executed automatically whenever you distill a PostScript file. 

SP TimeSavers will have no effect on PostScript files that do not include the pdfmark operator (such 
as FrameMaker print files that were produced with Generate Acrobat Data turned off ), or on PostScript 
print files produced by applications that do not generate pdfmark commands.

Creating Shortcuts to SP TimeSavers Configuration Files 

Depending on your distilling needs, you may frequently need to alter settings in 
SP TimeSavers configuration files. It is recommended to create shortcuts to the 
TimeSavers configuration files (TS-set.fni, TS-set.ini, TS-short.ini, TS-prolog.ini, 
TS-epilog.ini) on your desktop; double-clicking these shortcut icons will open the files 
in the associated text editor.

If you are using Windows, follow these steps to create shortcuts:

1 Click the Show Desktop icon if available, or minimize applications, to change the 
view so that you see the desktop.

2 Right-click a vacant location in the desktop, and select New > Shortcut. 

3 Browse to locate the SP TimeSavers configuration files in the Distiller/TimeSavers folder (e.g. 
TS-set.fdf, TS-set.ini). 

4 Click Next and select a title (or leave the file name as the title); click Finish.

5 Repeat for other files.

To create a Ctrl-Alt shortcut key for the configuration file (recommended), continue with these steps:

6 Right-click the icon you just created, and select Properties.

7 Click the Shortcut tab, and place the cursor in the Shortcut Key field.

8 Press a letter that will be used with Ctrl and Alt keys held together (for example “f” for the TS-set.fdf 
file so that Ctrl-Alt-f will instantly open the file in Acrobat; “s” for the TS-set.ini file so that Ctrl-Alt-s 
will instantly open the file in the associated text editor).
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Validating the Resolution Setting

To validate your resolution setting, open the calibrate.fm file (included with the TimeSavers) in 
FrameMaker, and print to a PostScript file, making sure that the current printer driver is the required 
one, and that the Generate Acrobat Data option is turned on. Distill and inspect the resulting PDF file. 
The 1-inch red square should be located between the two hollow rectangles, evenly occupying the gap 
between them.

A note on using SP TimeSavers with Acrobat 3

SP TimeSavers are fully functional with Acrobat 3. However, due to limitations of Acrobat 3, a number 
of the techniques used by SP TimeSavers result in a blank letter-sized page, appended to the PDF 
produced. This blank page has to be deleted manually in Acrobat Exchange (possibly when optimizing 
the PDF).

Installation of SP TimeSavers under Acrobat 3 is similar to the steps described for Acrobat 4 and later, 
except that the prologue.ps and epilogue.ps files are placed in the Distiller folder (and not in the 
Distiller/Data folder). 

To activate the TimeSavers, from the Distiller menu select Job Options; click the Advanced tab, and turn on 
the Distill with Prologue/Epilogue option. 

Using SP TimeSavers in conjunction with a watched folder

Place the TimeSavers prologue.ps and epilogue.ps files in the watched 
folder; all other files stay in their standard location (Distiller/TimeSavers 
folder).

Activate the Use Prologue.ps and Epilogue.ps option in the job options 
for the watched folder. 

In

Out

Watched
Folder

PS

PDF

prologue.ps &
epilogue.ps
go here
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Validating your installation of SP TimeSavers

Using FrameMaker, create a PostScript print file from the FMAC.fm example file and distill it. Compare 
the resulting PDF file with the supplied FMACtest.pdf file.

Disabling SP TimeSavers temporarily

In Acrobat 4 and later: Click the Job Options drop-down list and select a different set of jobs options 
in which the Use Prologue.ps and Epilogue.ps is turned off (use the PrintOptimized or PressOptimized 
predefined sets of job options, or any other saved set).

In Acrobat 3: From the Distiller menu, select Job Options. Click the Advanced tab, and turn off the Distill 
with Prologue/Epilogue option.
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Example File
The supplied FMAC.fm FrameMaker file includes examples of how SP TimeSavers functions can be used. 
The file includes, in addition to content, markers which control TimeSavers settings or define Acrobat 
features.

After distilling, the resulting PDF file should be displayed in a Full-Screen mode when opened in Acrobat. 
Press Escape to view the file with Acrobat menus and toolbar. Click the Bookmarks button (or tab in 
Acrobat 4 and later) to display the page together with bookmarks.

PDFmarker

The FMAC.fm file includes pdfmark and setdistillerparams commands, inserted using FrameMaker 
hypertext markers. 

You can inspect the code in various markers by opening the Special > Hypertext dialog box and selecting 
the marker you wish to view.

CollapseBookmarks

The bookmarks are collapsed under a single bookmark, which is at the top of the bookmark hierarchy.

The CollapseBookmarks utility is turned off by default (in the SP TimeSavers configuration files), but 
was turned on specifically for this file using a PDFmarker.

PDFmarkers in the FMAC.fm file do the following:

• Set the initial display mode to Full Screen

• Insert an open note, with control over size, title and color

• Control various bitmap downsampling options

• Turn on/off other TimeSavers (VisLinks, ParaNumOut, CollapseBookmarks)

• Send a message to be displayed in the Distiller Message Window

• Launch an external file and link to a web site. Note: with FrameMaker 5.5 and later, both actions can 
be achieved using hypertext commands; the two PDFmarkers are included to show how this can be 
done in earlier releases of FrameMaker and as a demonstration of pdfmark commands.

• Define a transition effect for the first page

• Create bookmarks to a web page and e-mail address

The markers are emphasized for your convenience, using a large font size and different colors. This 
emphasis has no functional significance. When you insert markers into your files, use markers in the 
normal manner.
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VisLinks

The links defined in FMAC.fm will be visible in the PDF (blue border). Note that the VisLinks utility is 
turned off by default (in the TimeSavers configuration files), but was turned on using a PDFmarker on 
page 1, and turned off on page 3. Therefore, the link on page 3 does not have any visual properties.

ParaNumOut

ParaNumOut, turned off by default (in the TimeSavers configuration files), was turned on for this file 
only using a PDFmarker in the FrameMaker file. While FMAC.fm includes numbered paragraphs (see the 
actual headings in the page window), these numbers do not appear in the bookmarks.

LinkReporter

View the Temp_lnkrpt.txt file in the Distiller/TimeSavers folder for the report that is generated as a result 
of distilling the FMAC.ps PostScript file.

setdistillerparams Commands

In FMAC.fm, the same picture is present three times on different pages. With the setdistillerparams 
command, you can control various image parameters (page-wide, but not for individual pictures within 
the same page). The various distilling parameters are changed from within the file for demonstration 
purposes.

If you use FrameMaker versions earlier than 5.5.6, the setdistillerparams command is inserted on 
page 1 but is effective only from page 2 onwards. With FrameMaker 5.5.6 and 6.0, the effect will be 
visible on the first page too.
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Activating Functions

By default, only PDFmarker is activated in the Configuration Panel (or set to /Y in the TS-set.ini file); 
all other functions are turned off.

To change default settings using the Configuration Panel:

Double-click the TS-set.fdf file (full Acrobat version is required), make the necessary changes and 
then click the Register Settings button.

The values are saved in the TS-set.pdf file and exported to the TS-set.fdf file, which is read by the 
TimeSavers (default). Make sure that in the Export Form Data As, the Distiller/TimeSavers folder is 
displayed, and then double-click the existing TS-set.fdf file to overwrite it.

Note: If you wish to change the default location of the TS-set.fdf file, change the corresponding 
entry in the TS-set.ini file (use a single forward slash when specifying folders).

To change default settings without the Configuration Panel:

If you don’t have the full version of Acrobat, or if you wish not to use the Configuration Panel, you can 
use a text editor (such as Notepad), adjusting the /Y (yes) or /N (no) values in the TS-set.ini file to 
turn the respective options on or off.

To disable reading values from the configuration panel, open the TS-set.ini file and change the first 
setting, under the “Read Settings From Fdf Info?” heading (this is done once).

• The TS-set.fdf file must be saved in the Distiller/TimeSavers folder. If you would like to store the file 
in another location, change the corresponding setting in the TS-set.ini file.

• The TS-set.fdf file has to be opened with the full version of Acrobat (not Acrobat Reader). If needed, 
modify the association of the FDF extension accordingly.

• The file format of all .ini files must remain text only. If you use FrameMaker to edit the file, save it 
with the Save As command, and under ‘Save as Type’ choose ‘Text Only’, and then choose ‘Put Carriage 
Return at the End of Each Line’ option. Make sure that the filename remains the same, and that no 
additional extension is appended (some text editors automatically append other extensions to 
edited files).

• There are four definitions which can only be set through the TS-set.ini file, and do not have 
corresponding settings in the Configuration Panel: PrinterDriverResolution, FilePath (for the DistillP 
command) and UnBloatProgressIndicator, and Custom Colors.
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When SP TimeSavers are activated, 
every time you distill a PostScript 
print file, the Acrobat Distiller message 
window will display messages 
notifying you of the options currently 
activated.

When the distilling is completed, a log 
file (with the same name as the PDF 
and a .log extension) is created in the 
same folder as the PDF file. 

All messages sent to the Distiller 
Window by SP TimeSavers are 
recorded in this log file.
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Controlling Bookmarks

CollapseBookmarks
FrameMaker uses specified paragraph tags and hierarchy (reflected by the indentation level) in the PDF 
Setup dialog box (or Acrobat Setup in FrameMaker 5.x) to automatically create bookmarks in Acrobat.

If first-level bookmarks have less than 24 subordinate bookmarks, FrameMaker creates first- and second-
level bookmarks in an expanded form, i.e. all bookmark levels are displayed (third-level bookmarks are 
collapsed). If, however, first-level bookmarks have more than 24 subordinate bookmarks (not including 
subordinates of subordinates), the entire bookmark hierarchy is collapsed. There is no way to control 
collapsing/expanding from within FrameMaker.

In general, collapsing all bookmarks to the top levels is recommended, since the bookmark structure 
of the document is easier to read and understand when collapsed. 

If you do not want SP TimeSavers to make any changes to the bookmark collapse/expand status as 
generated by FrameMaker, CollapseBookmarks should be turned off (default).

CollapseBookmarks automatically collapses the Acrobat bookmark hierarchy created by FrameMaker 
to first level bookmarks if CollapseBmkLevel has a value of 1, or to second level bookmarks if 
CollapseBmkLevel has a value of 2 (a value of 3 or higher will be interpreted as 2). 

without CollapseBookmarks collapsed under first level collapsed under second level
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ParaNumOut
When FrameMaker generates bookmarks, it uses the paragraph text, together with all automatic 
paragraph numbers. FrameMaker does not enable you to disable the inclusion of paragraph numbers. 
In most situations, these numbers are not necessary in bookmarks, which are clicked to directly access 
a topic. On the contrary, they occupy premium screen real-estate, and might be distracting. 

The ParaNumOut function removes the numeric string in the beginning of Acrobat bookmarks created 
by FrameMaker. 

ParaNumOut and Custom Bookmarks

Custom bookmarks specified through hypertext markers with the TimeSavers’ PDFmarker function are 
not affected by ParaNumOut.

Custom bookmarks specified through PostScript text frames or the TimeSavers’ TS-prolog.ini file 
(or files referenced in it) are also affected by ParaNumOut, if activated. If you wish that such bookmarks 
not be affected by ParaNumOut, use pdf as an ending command (instead of pdfmark).

Fine-Tuning ParaNumOut

If your automatic paragraph number starts with an alphabetical text string (e.g. “Figure”, “Note”) it will 
not be removed. However, if a single letter (with or without a punctuation mark) precedes the 
paragraph number (e.g. “A5.2.5” or “C-1”) the whole string will be removed (including the 
letter/punctuation).

You can specify that a certain repeated word prior to the number will be removed using the 
RemoveRedundantBmkStart function; ParaNumOut will then remove the number that followed it. 
If you need to remove a repeated word, but don’t want the number that follows it to be removed, even 
though ParaNumOut is active, use ChangeBmkStart instead of RemoveRedundantBmkStart.

without ParaNumOut with ParaNumOut
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ParaNumOut cannot differentiate between numbers at the beginning of a bookmark which come from 
an autonumber definition or numbers typed directly in the paragraph text. Any number preceding the 
bookmark text will be removed, depending on ParaNumOut settings.

A bookmark which is shorter than the number of characters specified by PNBmkPre-MinLength is not 
processed by ParaNumOut (default value is 3). 

If the text portion following the number at the beginning is less than the number of characters specified 
by PNBmkPost-MinLength, the number will not be removed (default value is 2).

MergeBookmarks
Depending on your template design in FrameMaker, chapter numbers or section numbers may be set 
as a separate paragraph, whose only function is to output the number, followed by another paragraph 
with the chapter title. When the chapter number paragraph is included in the list of bookmarks, it 
appears accordingly in a bookmark of its own.

When MergeBookmarks is activated, two such bookmarks are merged into one, and the merged 
bookmark points to the location indicated by the second bookmark.

A separator string – by default, a colon followed by space – is placed between the merged bookmarks. 
To change the separator string, edit the MergedBmkSeparator entry. The separator can be a just a single 
space, if the bookmarks that you are merging with the following ones end with a punctuation symbol.

For the merging of bookmarks to take place, two conditions have to take place: (a) the length of the short 
bookmark should not exceed the value set by MergedBmkShortMaxLength (default value is 2); and (b) the 
length of the following bookmark must be at least the length specified by MergedBmkNextMinLength 
(default value is 5).

These settings prevent the inappropriate merging of bookmarks – for example in the case of a series of 
short bookmarks for index letters.

In the PDF Setup > Bookmarks dialog box in FrameMaker, the hierarchy of the short first bookmark 
(typically the chapter number) should be set to be the same as that of the following tag (typically the 
chapter title), whose subordinate bookmarks (if any) become subordinates of the merged bookmark.

The merged bookmark is not affected by the ParaNumOut function (if activated) so the number at the 
beginning of the merged bookmark will remain intact.

MergedBmkMaxLevel will prevent the merging of bookmarks from taking place if the merged 
bookmark exceeds the specified level (default value is 2).

without MergeBookmarks with MergeBookmarks
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ExtractFigureBookmarks & ExtractTableBookmarks 
Bookmarks to figures and tables could be helpful to readers browsing through technical documents. 
However, just including the paragraph tags for figure and table titles in the PDF Setup would result in 
these items spread all over your bookmark list, on different levels, and many of these are likely to be 
hidden initially. As a result, common practice is not to include bookmarks for tables and figures, at best 
only including a bookmark for the page where a list of tables or figures is present.

The ExtractFigureBookmarks and ExtractTableBookmarks functions make it easy to create 
bookmarks for all figures and tables and place them either at the beginning or the end of the bookmark 
list, under a corresponding heading, initially expanded or collapsed as needed.

When SP TimeSavers operate on bookmarks produced by FrameMaker, these have no traces of the 
corresponding paragraph tags used in the FrameMaker file. Figure and Table bookmarks are identified 
as such based on the presence of a specific word in the beginning of the bookmark text: the words 
“Figure” or “Table” (case-sensitive; followed by a space). Adjust the values of the FigureBmkFlag and 
TableBmkFlag according to your paragraph formats. 

If you have table titles or figure captions without a “flag” word at the beginning, there is no way to trace 
these in the list of bookmarks.

While you can use figure and table bookmarks extraction functions separately or together, there are 
three entries that control both:

By default, extracted Figure and Table bookmarks are placed at the end of the bookmark list. 
Enable the ExtractedBmksAtStart entry to place them in the very beginning.

If your bookmark setup is such that you have one major first-level bookmark, under which all other 
bookmarks are collapsed, you can make the Figures or Tables bookmark headings subordinates 
of that first bookmark, by activating the ExtractedHeadSubOfFirstBmk setting. In the standard 

Important: Table and Figure bookmarks must not have subordinate bookmarks. To accomplish this, in 
FrameMaker’s PDF Setup use an arbitrary low level such as position 12, for both. Regardless of this low 
level, in the resulting PDF, all Table and Figure bookmarks will be placed under a first level bookmark 
with a corresponding heading: “List of Figures” or “List of Tables” (the title is generated by SP TimeSavers 
and can be changed by adjusting the FigureListTitle or TableListTitle accordingly.

Non-breaking spaces in figure or table “bookmark flag” 

If your autonumber setup includes a non-breaking space instead of a regular space 
(recommended so that when retrieved by cross-references, these will not split between lines), and 
the FixSpecialCharsInBmk option is not activated, the non-breaking space should be specified in the 
“bookmark flag” as \021. For example: (Figure\021). Your autonumber definition for both the <n=1> 
and <n+> variations (if used) should have the same type of space, as there is only one possible definition 
for the “bookmark flag”.

Notice that using a definition which only includes the word, e.g. (Figure), is technically possible and will 
catch both occurrences (ignoring the space altogether). When the flag text is removed (default), a space 
will be present at the beginning of the bookmark.
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configuration files it is disabled, which will make the Figures or Tables bookmark headings first level 
bookmarks. The table or figure bookmarks will be subordinates of these heading bookmarks, initially 
collapsed or expanded, based on the CollapseBookmarks setting.

The words used to identify table and figure bookmarks can be retained in the bookmark text by 
enabling ExtractionFlagTextKept. As the items are identified by their heading (such as “List of 
Tables” or just “Tables”), typically there is no need to keep the “flag” text in the bookmark.

without

ExtractTableBookmarks
ExtractFigureBookmarks &

with

ExtractTableBookmarks
ExtractFigureBookmarks &

The table and figure functions are generic in nature. You can use either of the two to extract Equation 
bookmarks or any type of bookmark which has a unique beginning, whose extraction and subsequent 
placement in one place makes sense.
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FixSpecialCharsInBmk
FrameMaker transfers various special characters to the bookmark text, but Acrobat and 
Acrobat Reader do not support them. Unsupported characters are displayed as boxes (particularly 
in Acrobat/Reader 5), shown as a space, or ignored altogether when viewing the PDF.

The FixSpecialCharsInBmk function handles this automatically by:

converting non-breaking hyphens to regular hyphens

converting non-breaking spaces, figure-, n- and m-spaces to regular spaces

removing thin spaces, suppress hyphen characters and discretionary hyphens.

with 
FixSpecialCharsInBmk

in Acrobat 4.0
(non-breaking hyphens
are missing)

in Acrobat 5.0
(non-breaking spaces & hyphens
are shown as boxes)

resulting bookmarks:

Headings in FrameMaker
(including non-breaking hyphens
and non-breaking spaces)

FM-to-Acrobat (non-breaking hyphens)
SP TimeSavers (non-breaking space)
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ReOrderCustomBookmarks
When you create custom bookmarks, you usually want to place them at the beginning or the end 
of the list of bookmarks. Depending on the specific FrameMaker release used, the positions of custom 
bookmarks in relation to those generated from paragraph styles may vary and can be difficult 
to control.

With ReOrderCustomBookmarks, when you create custom bookmarks through commands in 
PostScript text frames or using the TS-prolog.ini file (but not the TS-epilog.ini or custom epilogue 
files), you can force these to be at the top or bottom of the list of bookmarks. This is done by adding a 
special prefix in the bookmark text, which is removed automatically when the bookmark is positioned 
in place. The default prefix is T$ for a bookmark to be placed at the top, and B$ for a bookmark to be 
placed at the bottom. (Change these, if needed, by changing the values of the TopBmkIndicator and 
BottomBmkIndicator entries under ReOrderCustomBookmarks).

If you specify a number of bookmarks to be at the top or the bottom, final positioning will be based on 
the order of bookmarks in the PostScript file you are distilling, as written by FrameMaker.

The ReOrderCustomBookmarks function does not affect custom bookmarks inserted through 
commands or shortcuts in hypertext markers (with PDFmarker). 

If you need to define bookmarks using the TS-epilog.ini or custom epilogue files, so that they appear 
last, you must use a different command to end the bookmark – pdf instead of the standard pdfmark. 
For example:

[/Title (About) /Action << /Subtype /Named /N /About >> /OUT pdf

instead of 
[/Title (About) /Action << /Subtype /Named /N /About >> /OUT pdfmark

Using the standard pdfmark ending in a custom epilogue, TS-epilog.ini file or a file referenced in it 
will result in an error (Error: invalidaccess; OffendingCommand: writestring), as regular bookmark 
processing is fully completed before epilogue files are processed.

Alternatively, specify the bookmarks you want to be at the end of the list in the TS-prolog.ini file 
(or in a file referenced in it), using the standard pdfmark ending, and activate the 
ReOrderCustomBookmarks function.

When using SP TimeSavers, ending any pdfmark command with pdf instead of pdfmark will cause the 
command to be bypassed by the corresponding TimeSavers functions.



© 2001 MicroType

SP TimeSavers, FrameMaker Edition • Controlling Bookmarks 21

BookmarkStylerByText & BookmarkStylerByLevel (Acrobat 5)
Acrobat 5 supports new bookmark properties: color and style (plain, italic, bold, bold italic). 

The BookmarkStyler functions enable you to define these bookmark properties so that they are 
automatically created in the PDF, based on:

bookmark levels (BookmarkStylerByLevel) – for example all Level 1 bookmarks can be bold 
magenta, and/or

text strings (BookmarkStylerByText) – for example bookmarks with the text “new in this release” 
can be italic blue bookmarks. 

Strings specified under BookmarkStylerByText are case-sensitive. If you would like to style 
bookmarks containing “Configuration” or “configuration”, either define them as two separate strings, 
or refer to them both in one string by omitting the “c” and specifying “onfiguration”.

When PDFs created using Acrobat Distiller 5 are viewed in Acrobat 4, the color/font style bookmark 
properties are ignored without causing an error.

When using BookmarkStyler functions and distilling with Acrobat Distiller 4, color/font style bookmark 
properties are ignored. 
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ChangeBmkStart & RemoveRedundantBmkStart
For bookmarks to be identified easily, they need to have a unique beginning. In some publications, 
many bookmarks may have the same starting phrases: words such as Chapter, Section, Equation (or 
even the word “The”). 

With the ChangeBmkStart function, you can define up to 9 replacements (“from”–”to”) that will take 
place automatically, as you distill the file. For example: “Chapter” can be replaced with “Ch”. Only 
bookmarks are affected; actual page content remains intact. 

If you would like to remove a non-unique beginning without replacing it with something else, use the 
RemoveRedundantBmkStart function. 

If you are using the TS-set.ini file, adjust the relevant entries under these functions and delete the 
percent symbol in the beginning of lines to activate the settings.

All strings specified (“from”-”to”) are case-sensitive.

without with
RemoveRedundantBmkStart RemoveRedundantBmkStart

Technically it is possible to use a “from”-”to” replacement and specify an empty “to” (open and close 
parentheses without a space in between). It is recommended, however, to use the 
RemoveRedundantBmkStart function for deletions and ChangeBmkStart for replacements, unless 
you have an additional consideration related to a redundant word in conjunction with a paragraph 
number. RemoveRedundantBmkStart is executed before the ParaNumOut function (if activated); 
ChangeBmkStart is executed after these, so it will apply to combinations of number + redundant 
word.

MergeBookmarks, if activated, is executed after both RemoveRedundantBmkStart and 
ChangeBmkStart.
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Controlling Link Properties

VisLinks
When FrameMaker creates Acrobat links from cross-references and regular hypertext markers, it sets 
their properties – rectangle location and dimensions, border style ( = none), border color ( = invisible) 
and highlight style ( = invert). FrameMaker doesn’t allow you to control these settings. To change them, 
you have to use Acrobat, select each link and set its properties, one link at a time (or use an Acrobat plug-
in which allows you to set multiple links).

With VisLinks, you can globally control all these settings: border line width, line style (continuous/dash), 
line color and highlighting style. FrameMaker’s cross-references and hypertext links will then be marked 
with rectangles, with the specified properties, displayed accordingly in the PDF file. 

Making Acrobat links visible, even if not required in the final version, can be useful when creating and 
testing PDF files, especially with text-intensive PDFs.

When VisLinks is turned on, the link properties which are automatically set, affect the display only. If the 
VisLinksPrint option is activated, the link border is marked with a rectangle on the printed page as well 
as being displayed on the screen. 

without
VisLinks

with
VisLinks

VisLinks only affects links created by cross-references and regular hypertext markers. Custom links 
created either through PS text frames or commands/shortcuts in hypertext markers (with PDFmarker) 
are not affected by VisLinks. To set the link style in custom links, add the appropriate parameters to the 
link command itself.

The format of the link’s text is not changed and can be controlled only from within FrameMaker.
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Adjust the link rectangle properties as needed, using the Configuration Panel or editing the TS-set.ini 
file. 

To change the link highlighting style when it is clicked, edit the HighlightStyle entry. Any of the four 
options below can be specified: 

If you only want to define highlighting style, but do not want a border to appear, use a border color 
similar to your background color (normally white).

VisLinks can use different colors for external and internal links, /ExtBorderColor and /IntBorderColor – 
these may be useful, for instance, for diagnostics.

ForceNewWindow 
Activating this control will cause FrameMaker-generated cross-file links to be opened in a separate 
window – regardless of whether the link is the result of a cross-reference, gotolink/openlink or 
message openfile command, overriding the local Acrobat Reader preference of “Open Cross-
Document Links in Same Window” (File > Preferences > General). The ForceNewWindow setting can be 
activated globally, or turned on in a specific file or in a portion of a file.

Cross-file links which are the result of your own pdfmark commands (e.g. a bookmark which opens 
an external file) are not affected by this setting. Include the necessary code fragment in the pdfmark 
commands to achieve the required result.

ChangeFileNameCase 
Activating this control will cause path/file names in cross-file links to be converted to all lower case or 
all caps. This option may be useful when developing interactive PDFs to be viewed in platforms where 
file names are case-sensitive.

You can specify the automatic adjustment of link rectangles in all four directions – and all rectangles 
will be expanded/reduced accordingly. Use negative values to shrink the rectangle. This must be done 
in the TS-set.ini file. Locate the following section and change values as required:

%%% link rectangle adjustments
/ExtendBorderX         4 def
/ExtendBorderYTop      2 def
/ExtendBorderYBottom   2 def

None Invert Outline Inset

/N /I /O /P
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Adding Commands with PDFmarker

Without PDFmarker, Acrobat commands can be inserted in FrameMaker files only inside text frames 
tagged as PostScript Code. These frames are clumsy and clutter the screen (and sometimes your 
output), and are limited in their functions. 

With PDFmarker, you can use regular hypertext FrameMaker markers to specify PDF features in your 
FrameMaker files.

When processed by Distiller, the PDF features you specify will be created automatically. Depending on 
the commands you define, the resulting PDF can include, for example: 

Your own document information fields (such as document title and keywords, so that when you use 
the Search function, meaningful titles of documents will be listed)

Notes (with control over title, location, color, size)

Custom bookmarks (for example, opening URL, launching applications, pointing to other 
documents)

Default document view settings (for example, Resize Window to Initial Page, which displays the 
DocInfo Title field in the title bar).

Page actions (actions which take place when a page is opened or closed) and presentation controls 
(transition effects, duration of display)

Named destinations you can control (if you want to link from an HTML page to specific locations in 
your PDF file)

Form fields for enhanced interactivity (e.g. pop-ups, non-printing buttons)

Multimedia features (such as audio effects and movies).

Once you have set the required PDF attributes, you will no longer need to redefine them in Acrobat every 
time you create the PDF file.

In addition, you can use PDFmarker to insert setdistillerparams commands in FrameMaker, insert 
PostScript commands and/or control TimeSavers settings. 

To insert markers with Acrobat commands:

1 In FrameMaker, select a cursor location and then insert a hypertext marker (Special > Hypertext).

The Hypertext dialog box is opened.

2 In the text box, type (all lower case, no capitals/caps) the word alert, followed by your Acrobat 
command text/arguments.

This command can be a pdfmark or setdistillerparams command, or a special PostScript command 
– see following pages for details.

3 Click the New Hypertext Marker button when done.

Your marker is now inserted.

In a PDFmarker (hypertext alert marker containing PDF-related commands), you can specify coordinates 
qualified with the point (pt) and inch (in) measurement units. These measurement units are dependent 
on the resolution defined in the printer driver being used.
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The PrinterDriverResolution value in TS-set.ini (no corresponding entry in the Configuration Panel) 
is set by default to 600 dpi (corresponds to the default setting of the Acrobat Distiller PPD). Macintosh 
users should set this value to 72. 

Inserting pdfmark Commands
When inserting the marker text, do not insert the word “pdfmark” at the end of the marker text. The left 
square bracket ([) at the beginning of the pdfmark command is inserted as usual (after the word alert, 
with a space separating the two). 

As an example, the following pdfmark sets the initial viewing state of the PDF file to show the thumbnail 
window, and to open the PDF on page 2: 

If you have not used markers before, it is recommended that you read the FrameMaker documentation 
for a description of how to find, edit and delete markers.

To insert new line characters in a command, press Enter at any point. This does not activate the New 
Hypertext Marker button.

If you plan to specify coordinates in a PDFmarker, verify that this value matches the resolution of your 
printer driver. To see the resolution of the your printer driver, choose Print Setup > Properties in 
FrameMaker. If necessary, change the value of PrinterDriverResolution in TS-set.ini.

If you need to insert and/or edit a large number of markers, consider using IXgen, a marker 
management utility from Frank Stearns Associates (www.pacifier.com/~franks)

http://www.pacifier.com/~franks
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1 In FrameMaker, select File > New > Explore Standard Templates (FrameMaker 6.0: File > New > Document 
> Explore Standard Templates). Choose Report, Plain, and click Show Sample. 

2 Save the file as TMS-Practice.fm.

3 Using the procedure listed previously, insert a pdfmark statement to set the initial view to full-screen 
mode.

The marker text box should include the following text:
alert [/PageMode /FullScreen /DOCVIEW

4 Choose File > Print. In the PDF Setup dialog box, move all paragraph formats to the right scrolling list, 
so that no bookmarks are produced.

5 With Generate Acrobat Data turned on, print all pages to create a PostScript file. 

If the ‘Generate Acrobat Data’ checkbox is turned off, your markers will not be present in the 
PostScript file.

6 Save the FrameMaker file (it will be used in the next practice example).

7 Distill the file and open the document in an Acrobat viewer.

The file will be opened in full-screen mode. 

Practice:
Inserting a pdfmark Command Using a Hypertext Marker

See discussion of the conflict between bookmarks and the /DOCVIEW pdfmark on page 44. With the 
IgnoreDOCVIEW setting in the TimeSavers you can control this conflict, and have FrameMaker create 
bookmarks and nevertheless be able to specify the opening mode. The IgnoreDOCVIEW setting can be 
changed in the Configuration Panel or TS-set.ini file (and then it is the default), or changed in 
individual files using a hypertext marker:
alert /Y /IgnoreDOCVIEW TSset

alert [ markers are “encapsulated”, i.e. the environment is saved before the marker is executed and 
restored when processing is completed. The alert [ marker therefore cannot include changes of 
general settings such as TimeSavers settings. With pdfmark commands, encapsulation has no practical 
effect. It has, however, an effect on files being referenced in a PDFmarker – see page 40.
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Using ~name Shortcuts
SP TimeSavers enable you to use shortcuts for frequently-used alert [ markers. The following 
shortcuts are pre-defined:

To activate a shortcut, start your marker text with alert ~  followed by the name used (e.g. alert ~DOC, 
alert ~page_trans). 

Note that names are case-sensitive (so that ~Jump, ~JUMP and ~jump are different shortcuts).

Shortcut Action Example

NamedAct named action alert ~NamedAct /Print

Search Acrobat Search action alert ~Search 

link general link template alert ~link /Page /Next

JSlink link with JavaScript action alert ~JSlink (JavaScript code)

xlinkf open another PDF in a new window alert ~xlinkf (file.pdf) 

movie create a link to a movie file alert ~movie (Title) (sample.mov) 

baseURL set a base URL alert ~baseURL (http://www.xyz.com) 

bmf define bookmark to a file alert ~bmf (click to open) (file2.pdf) 

bmu
define bookmark to a web URL 
or e-mail address 

alert ~bmu (send feedback) 
(mailto:abc@gen.com?Subject=XYZ manual) 
alert ~bmu (visit my web page) 
(http://www.xyz.com)                  

tnote
create Acrobat 4 (and later) note icon + 
a conditional statement 

alert ~tnote (Tip) (Read the instructions 
carefully) 

DOCINFO set DocInfo fields
alert ~DOCINFO (Title) (Subject) (Author) 
(keyword;keyword;keyword)

DOC
specify DocInfo fields + DocView 
settings 

alert ~DOC (Title) (Subject) (Author) 
(keyword;keyword;keyword) 

View set initial view settings  alert ~View 

SetView specify additional DocView settings  alert ~SetView /HideToolbar true 

dtrans specify a Dissolve transition  alert ~dtrans 1.5

PDX attach an index  alert ~PDX (index.pdx)

PageOpen “page open” action 
 alert ~PageOpen /S /Named /N 
/SecurityInfo                                  

Prefix assign a page label  alert ~ (prefix-)                                  

rm bookmark & revision mark  alert ~rm (RC:my comment...)                                  
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Defining and Modifying Shortcuts
Repetitive fragments are defined as a named shortcut in the TS-short.ini file. In addition to being 
defined in the TS-short.ini file, shortcuts can be defined (or redefined) in external text files which are 
activated through TS-prolog.ini, or using PDFmarkers.

Each shortcut is composed of two parts, begin and end – both of which must be defined, but can be 
defined as empty if necessary. 

For example, if you define a shortcut for a complete pdfmark command to create a bookmark to a web 
site, then the marker text will only be alert ~MyWebPage

The definition for the shortcut could be:

%%% MyWebPage %%%%%%%%%%%%%%%%%%%%%%

% bookmark to my web site
% use: alert ~mywebpage

/alert~MyWebPage_begin
{ /Title (my web page) } def

/alert~MyWebPage_end
{ /Action << /Subtype /URI /URI http://www.abc.com >> /OUT } def

Or, equally:

/alert~MyWebPage_begin
{ /Title (my web page) 
/Action << /Subtype /URI /URI http://www.abc.com >> /OUT }

def

/alert~MyWebPage_end
{ }
def

Or:

/alert~MyWebPage_begin
{ }
def

/alert~MyWebPage_end
{ /Title (my web page) 
/Action << /Subtype /URI /URI http://www.abc.com >> /OUT }

def
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Likewise, a ~MyBaseURL shortcut can be used to define a base URL (which serves as a prefix for all URLs 
used which do not start with http://):

%%% MyBaseURL %%%%%%%%%%%%%%%%%%%%%

% base URL
% use: alert ~MyBaseURL 

/alert~MyBaseURL_begin
{ {Catalog} << /URI << /Base 
(http://www.xyz.com/)
 >> >> /PUT } def

/alert~MyBaseURL_end
{ } def

To define a general shortcut, which uses a specified web address for the base URL, you can combine the 
shortcut with a changing continuation. The marker text will then be of the form alert ~BaseURL 
(address), in which case the begin part is automatically placed before the (address), and the end part 
is placed after the (address). The part that you enter after the ~name shortcut is wrapped with the begin 
and end parts. The shortcut will be defined as:

%%% BaseURL %%%%%%%%%%%%%%%%%%%%%

% base URL
% use: alert ~BaseURL 

/alert~BaseURL_begin
{ {Catalog} << /URI << /Base }
def

/alert~BaseURL_end
{ >> >> /PUT }
def

Hypertext markers using this shortcut could be:

alert ~BaseURL (http://www.abc.com/)
alert ~BaseURL (http://www.xyz.com/products/)
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The TS-short.ini shortcuts file defines similar shortcuts for:

• complete commands to inherit the active marker area, as set by FrameMaker; suppress borders; 
activate a specific named action (Search, Quit), and a “named action” template, which uses a 
specified named action

• bookmarks to a file or to web addresses

• DocView and DocInfo settings 

• Page transition effects.

Depending on the commands and required syntax, with the more complex commands you might need 
to change the order of items on the stack and/or save temporary variables. 

The alert ~ shortcuts are “encapsulated” (similar to alert [ markers), which means that the 
environment is saved before the shortcut is executed and restored afterwards. Shortcuts therefore 
cannot include changes of settings, such as general variables and/or TimeSavers settings. 
With relation to pdfmark commands, encapsulation has no effect.
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Two or More pdfmark Commands in a Single PDFmarker
A single PDFmarker can be used to insert more than one pdfmark command. When your hypertext 
marker starts with alert [ , the ending pdfmark command is added automatically. To have more 
than one pdfmark statement in a single PDFmarker, use the following syntax:  

alert [ ... pdfmark [ ... pdfmark [ ...

1st pdfmark
statement

2nd pdfmark
statement

3rd pdfmark
statement

(ending pdfmark 
added automatically)

Acrobat Features Inserted with PDFmarkers, But You Get Note Icons Instead

Closed note icons in the PDFs, present wherever you placed hypertext markers with various pdfmark 
commands, imply that the markers have not been executed properly. This can happen for any of the 
following reasons:

• The TimeSavers are not active (Distiller Job Options > Advanced; the Use Prologue.ps/Epilogue.ps 
setting must be turned on)

• PDFmarker is turned off in the TimeSavers configuration files (Configuration panel, or TS-set.ini 
if the Configuration Panel is disabled)

• Your marker text does not start with the word alert.

• The command does not start with a [, ~, << or / (after the word alert, followed by a space)

• You are distilling using a watched folder (see page 8 for details on using the TimeSavers with watched 
folders).

Acrobat Features Inserted with PDFmarkers, But Without Any Trace in the PDF

This can happen for any of the following reasons:

• If the ‘Generate Acrobat Data’ checkbox is turned off, your markers will not be present in the PostScript 
file.

• If you use the first release FrameMaker 6.0 (p357), hypertext markers placed on a master page will not 
be translated to Acrobat. Use the patch available from Adobe.com to upgrade to FrameMaker 6.0 
(p405).

Acrobat Feature Inserted with a PDFmarker Once, But You Get Multiple Instances

This can happen because of the following:

• Due to a FrameMaker bug, the same single marker may be written to the PostScript file more than 
once. Cut the content of the marker and paste it in a temporary file, delete the marker, and then 
recreate it. To minimize this problem, SP TimeSavers 3.1 now skip duplicate PDFmarkers that are 
consecutive, on the same page.

• If you defined a feature in the last paragraph on a page which is also entirely active (no character 
formats to limit the active area), the item will be duplicated on the next page, as a result of 
FrameMaker bug (common to all FrameMaker 5.x releases, fixed in FrameMaker 6.0).
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Inserting Special PostScript Commands and TimeSavers Options
For a marker to be interpreted as a PostScript command, the marker text has to start with a forward 
slash (after the word alert). 

If you need to use the slash as the first character in your PostScript command, add text immediately after 
it. If you do not need the forward slash as the first character in your command, leave a space after the 
slash, write the pop command, followed by a space, and then start typing your commands.

For example, if your marker text is alert / pop (Your Message) = the message enclosed in the 
parentheses will be displayed when Acrobat Distiller processes the page where your marker is placed.

1 Open the TMS-practice.fm file you saved in the last exercise.

2 Insert a PostScript command to display a message in the Acrobat Distiller Message Window.

The marker text box should include the following text:
alert /Y /ParaNumOut TSset (ParaNum taken away) =

3 Save the FrameMaker file (it will be used in the next practice example).

4 Create a PostScript print file.

5 Distill the file and inspect it.

Paragraph numbers in the bookmarks should be suppressed, the message in parentheses should be 
displayed in the Distiller message window in the process of distilling.

You can use this mechanism to change SP TimeSavers settings. For example, inserting the command 
alert /N /ParaNumOut TSset will disable ParaNumOut if it was initially activated. Remember that 
these commands are interpreted only if PDFmarker is active.

• If you are using a PostScript procedure you have defined in the TM-prolog.ini file, you can include 
the pop command as part of the procedure.

• As with alert [ markers, you can reference the active area set by FrameMaker with the XLL, YLL, XUR 
and YUR variables.

• alert / markers are executed in an unencapsulated environment, and they can therefore change 
various settings outside the marker scope (e.g. TimeSavers settings, PostScript variables etc).

Practice:
Setting a TimeSavers option through a hypertext marker



© 2001 MicroType

SP TimeSavers, FrameMaker Edition • Adding Commands with PDFmarker 34

Inserting setdistillerparams Commands
When inserting the marker text, do not insert the setdistillerparams at the end of the marker text. 
The two opening angled brackets (<<) at the beginning of the setdistillerparams command are 
inserted in the usual manner (after the word alert).

Several setdistillerparams operators can be placed together within one command, as in the following 
example: 

The location of a setdistillerparams marker on the page is insignificant.

With FrameMaker releases earlier than 5.5.6, your setdistillerparams marker is effective from the 
following page onwards.

In FrameMaker 5.5.6 and later, a setdistillerparams marker is effective from the current page 
onwards.

setdistillerparams commands included in hypertext markers are effective only if the Allow 
PostScript file to Override Job Options setting (Job Options > Advanced) is activated. (Acrobat 3 does 
not have a similar setting).

setdistillerparams commands can only be inserted in FrameMaker using PDFmarker/TimeSavers. 
These commands are ineffective in PostScript text frames – this is because the graphics state is saved 
prior to the execution of the PostScript text frame, and restored after execution is completed – 
cancelling the outcome of the setdistillerparams command.
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Comments in PDFmarkers

To include a comment in a marker, you can add a percent symbol, followed by your comment (which is 
fully ignored). The portion up to the percent symbol must be a complete, valid statement. This is 
equally true for the different types of commands supported by PDFmarker (pdfmark, 
setdistillerparams and PostScript). For example:

alert / (c:/glossary/the.txt) distillQ PopUp % this is a comment

alert [ /Dest (MyDest) /DEST % this is another comment

alert << /ColorImageDepth 4 /DownsampleColorImages true >> % and another

Internal Order of Markers in FrameMaker

Whenever you insert a marker, it is assigned an internal object ID number by FrameMaker. PDFmarkers 
are written by FrameMaker in the order in which they are inserted (corresponding to the internal 
object ID number assigned by FrameMaker), page by page, and not according to position. In most 
circumstances, this order has no consequence. However, when you insert an alert / marker to 
activate an option, internal ordering on the page may be significant – the marker might be placed 
before another marker which you wish to control in terms of text position, but because it was inserted 
later in time, it is processed last. If you need to re-order markers and you already have PDFmarkers on 
the page, copy their contents first to a temporary file, delete your current markers, and then re-insert 
them in the required order. Copying and pasting the markers themselves does not change their 
internal ordering.

Acrobat Commands Placement Considerations

In FrameMaker 5.5.6 and later, hypertext markers are written by FrameMaker at the beginning of the 
PostScript description of the current page. If you insert a marker with a PostScript command, such as 
to activate a TimeSavers option, it will be effective starting on the current page. 

Thus, a marker intended to activate the VisLinks option, if placed on the first page of a FrameMaker 
document, will affect the links created by FrameMaker starting on the first page. If the same marker is 
placed on subsequent pages, if will not affect the links on previous pages (as these are already written 
to the PostScript file).

Starting with SP TimeSavers 3.0 and later (and all versions of FrameMaker), the Bookmark Controller 
handles all bookmarks generated by FrameMaker (or defined through PostScript text frames) after 
distilling of all pages is completed. Thus, markers affecting bookmark-related functions in the 
TimeSavers can be placed anywhere in a file.

If order is of significance, you can inspect the order in which your PDFmarkers are written by 
FrameMaker, by checking the report generated by the LinkReporter function (Temp_lnkrpt.txt 
in the Distiller/TimeSavers folder).
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TimeSavers Options and Where They Can Be Controlled

Inserting Regular Notes

The alert hypertext marker was originally intended to display a pop-up box in 
FrameViewer/FrameReader, and is translated by default to an Acrobat note (if Generate Acrobat Data 
is turned on). 

If your marker text starts with the word alert but is not followed with a left square bracket ([), tilde (~), 
forward slash (/) or left angled bracket (<), it is regarded as a regular hypertext marker, which is 
translated by FrameMaker to an Acrobat note, with no control over note color, size or title. (To insert a 
note in the PDF file and fully control its properties, use the corresponding /ANN pdfmark and set the required 
attributes or use a shortcut.)
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All other hypertext markers are translated by FrameMaker to corresponding Acrobat actions (if the 
Generate Acrobat Data box is checked when printing). 

Inheriting Marker’s Active Area

When relevant, you can reference the actual location of the marker in the definition of the pdfmark. 
If text or layout changes cause the marker to move to a different location on the page, the link/note 
will still be in the right place, if specified to be relative to the marker location.

To use a word, phrase, or paragraph to indicate an active area, select the text, change its character format 
and insert a hypertext marker in it. In Acrobat, this area is highlighted when clicked, and the command 
specified by the marker is performed.

The XLL variable indicates the horizontal location at the lower-left corner of the active area created by 
the marker; YLL indicates the vertical location at the lower-left corner of that active area. 

The XUR and YUR variables respectively indicate the horizontal and vertical location at the upper-right 
corner of the active area created by the marker.

To inherit the active area of the hypertext marker, use the /Rect [ XLL YLL XUR YUR] key-value pair:

alert [ /Rect [ XLL YLL XUR YUR ] ...

• You can temporarily disable individual Acrobat commands you insert using PDFmarker by inserting 
any character (other than [ < / or ~) after the word alert, for example a $ sign. The marker will then 
be converted to a closed Acrobat note, if Generate Acrobat Data is turned on. 
To reactivate the marker as an Acrobat command, delete the character you added.

• If you use PDFmarker to insert hypertext markers and your FrameMaker file is viewed with 
FrameViewer/FrameReader (or with FrameMaker when the document is locked as view-only), 
clicking the marker will show the text of the pdfmark command specified in it as a pop-up box.

The XLL, YLL, XUR and YUR variables are available when you use alert [ or alert / markers, but not 
with alert << markers.

• You can use various character format changes, such as italic, bold, underline, color or font, to mark 
the active area. 
Change bar, spread, case, and pair kerning settings are not regarded as a character format for the 
purpose of marking an active area.
If you need to designate a word or phrase as active without changing its character properties, use 
a character format that sets all properties to “As Is”.

• To use an entire paragraph to indicate an active area, make sure there are no character format 
changes in the paragraph and insert a hypertext marker in it. The entire paragraph will be 
highlighted when clicked, and the command specified by the marker will be performed. 
Be aware that, as a result of a bug in all FrameMaker versions up to FrameMaker 6.0, a link in the last 
paragraph on a page, entirely-active, is duplicated on the next page.
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Page Coordinates

Regardless of the marker location, coordinates specified numerically in a PDFmarker refer to the page; 
page origin (0,0) falls at the top left corner of the page (so, for example, a /Rect [ 0 0 72 pt 72 pt ] 
specification will refer to a 1" square in the top left corner of the page if inserted in a PDFmarker).

When specifying coordinates/dimensions, you must qualify them with a measurement unit: either pt for 
points or in for inches (lowercase letters).

Referencing External Files in a PDFmarker

You can use the distill or distillP commands to reference external files in a PDFmarker. This is 
useful for a repetitive code, a code that might be frequently changing, or as a workaround to the 
limitation of up to 255 characters for marker text (imposed by FrameMaker):

Place the required text/code segment in an external, plain text file.

In the PDFmarker, specify the full path, enclosed in parentheses, followed by the command distill, 
in the corresponding location. 

The file specification is platform-dependent. For example, 
Windows format is (c:/research/intro.ps) distill
Mac format is (PowerMac HD:Output:PostScript:note33.ps) distill.

The contents of this file will be integrated in place when distilling – a message including the file name is 
displayed in the Distiller message window.

If you use the distill command, specifying a file name only, the default path used is the Acrobat 
Distiller directory. The distillP command, however, uses a path you can set yourself in TS-set.ini 
(no corresponding value in the Configuration Panel), TS-prolog.ini, or through markers in the 
FrameMaker file, e.g.:
/FilePath (c:/Acrobat/Distillr/cmds/) def.

If you use the distill command many times in a specific file, the messages sent to the Acrobat Distiller 
message window might slow down the distilling process. In such a case, you can use the distillQ 
command, which has the same functionality but which does not send messages to the Distiller 
message window (Q=quiet).

The distill, distillP and distillQ commands can also be used in the TS-prolog.ini and 
TS-epilog.ini files.
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For example, it is possible to have an external file, for instance named file.txt, with the following 
contents:

/Title (WWW updates)

/Action << /Subtype /URI /URI (http://www.gen.com/updates.html) >>/OUT 

and the following marker:

alert [ (file.txt) distill 

The referenced file can later be expanded to include two different bookmarks (no need to change the 
marker referencing the file; or even to output the PostScript file again from FrameMaker, if no other 
changes in the file itself took place):

/Title (WWW updates)
/Action << /Subtype /URI /URI (http://www.gen.com/updates.html) >>/OUT pdfmark

[ /Title (latest FAQ)
/Action << /Subtype /URI /URI (http://www.gen.com/FAQ.html) >>/OUT 

Note that if there are no changes in the FrameMaker file itself, there is no need to regenerate the 
PostScript file and redistill – simply distill the existing PostScript file. 

Notice that the “missing” beginning square bracket and the ending pdfmark are not there because 
they are supplied by the alert [ marker).

distill vs. #include

If the TimeSavers are active, the distill command can also be used in PostScript text frames. 

When you use the #include "filename" in a PostScript text frame, the contents of the file are placed in 
the PostScript print file which FrameMaker creates; no external reference is made. 

The distill command, on the other hand, creates a reference to the specified external file, which 
remains a reference in the PostScript print file which FrameMaker creates. When the contents of the 
external file are changed and no other changes are present in your source FrameMaker file, you must use 
FrameMaker to regenerate the PostScript print file if you use the #include command, whereas if you use 
the distill command you only need to redistill.

The FilePath variable can be set by referencing the contents of a file via the distill command, e.g. 
alert /FilePath (file.txt) distill def. This allows an additional level of flexibility – for example, 
using different project locations defined with multiple pdfmark commands, and having only a few 
pointer files in the Distiller folder to lead to a whole set of other files located elsewhere. This might also 
be useful in developing products, where different features (transition effects, sounds, movies, link 
styles, etc.) can be placed in different folders. Then the PostScript files only need to be redistilled after 
the file path is changed to give the PDF collection a different appearance.



© 2001 MicroType

SP TimeSavers, FrameMaker Edition • Adding Commands with PDFmarker 40

Encapsulation and referenced files

When referencing a file from within a PDF marker, “encapsulation” has an effect you should be aware of. 
Encapsulation is the automatic save/restore which takes place before and after processing an alert [ 
marker (alert / markers are not encapsulated). 

With the alert / marker, the referenced file can contain any text and/or portion of commands, but the 
opening [ and pdfmark cannot be part of the file referenced in an alert / marker.

alert [ markers are encapsulated, and therefore there are no limitations as to the contents of the 
referenced files (except that these cannot contain setdistillerparams commands, which should be 
inserted with alert << or alert / markers).

If for some reason you need to specifically use the alert / marker and reference an external file 
containing multiple pdfmark commands in it, use the following syntax:
alert / pop save (file.txt) distill restore 

Take into account that:

with alert [ markers, the beginning [ and ending pdfmark are automatically added; with alert / 
this does not take place.

setdistillerparams commands are not effective when inserted in an encapsulated marker.

Adding Prologue/Epilogue Commands

In certain cases you may need specific Acrobat commands to be processed automatically before or 
after the PostScript file created for your source document. These must be placed in the TS-prolog.ini 
or TS-epilog.ini files respectively (in the Acrobat Distiller/TimeSavers folder).

Referencing External Files from the prologue/epilogue Files

In addition, you can create text files with the required commands and add references to them in the 
TS-prolog.ini or the TS-epilog.ini files, using the distill command. For example:

(cmds/ProjectABC.acd) distill
(cmds/ProjectXYZ.acd) distill 

It is recommended to include in files referenced in the TS-prolog.ini and/or TS-epilog.ini, relevant 
messages which will be displayed in the Acrobat Distiller message window when the files are processed 
(enclose the message to be displayed in parentheses, followed by the equal sign). 

• The above commands use a relative path – the cmds folder under the Distiller folder.

• It is recommended to insert each distill command on a separate line. This will make it easy to 
disable the processing of a single command file by inserting a percent character (%) at the beginning 
of the line to make it a comment.
This practice will prevent your TS-prolog.ini and TS-epilog.ini files from being cluttered with 
commands. It is easy to disable the specific line temporarily by adding a % character at the beginning 
of the line, and activating it again later by removing the % character.
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Choose any filename/extension for referenced files and consider using consistent extensions which will 
indicate their use.

Specifying Custom Epilogue Files

If you want to add a job-specific epilogue, you can insert the CustomEpilogue command in a 
PostScript PDFmarker, preceded with a file name enclosed in parentheses. Your marker text will look 
like this:

alert / (filename.ext) CustomEpilogue

If you specify the file name only, the default path used is the Acrobat Distiller directory (if you use a 
relative path, it is relative to the Distiller folder).

The contents of this file will be processed after the PostScript file is processed. 

If a custom epilogue file is used after your PostScript file is distilled, the following message will be 
displayed in the Distiller message window, followed by the filename:

*** processing custom epilogue 

If you need to define bookmarks using the TS-epilog.ini or custom epilogue files, so that they appear 
last, you must use a different command to end the bookmark, pdf instead of the standard pdfmark. 
For example:

[/Title (About) /Action << /Subtype /Named /N /About >> /OUT pdf

instead of 
[/Title (About) /Action << /Subtype /Named /N /About >> /OUT pdfmark

Using the standard pdfmark ending in a custom epilogue, TS-epilog.ini file or a file referenced in 
it will result in an error (Error: invalidaccess; OffendingCommand: writestring), as regular bookmark 
processing is fully completed before epilogue files are processed.

Alternatively, specify the bookmarks you want to be at the end of the list in the TS-prolog.ini file 
(or in a file referenced in it), using the standard pdfmark ending, and activate the 
ReOrderCustomBookmarks function.
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FrameMaker Controls

When you create a PostScript print file with the Generate Acrobat Data option turned on, FrameMaker 
generates pdfmark commands which are embedded in the PostScript print file. The actual 
combination of these pdfmark commands will vary, depending on your FrameMaker file content and 
the PDF Setup options activated, but it typically includes the /OUT (bookmarks), /ANN (links and notes), 
and /ARTICLE (article threads) pdfmark commands.

FrameMaker always inserts a /DOCINFO command (where it identifies itself as the creator application) 
and a /PAGE command to set page cropping. In addition, when FrameMaker 5.5 (and later) creates 
bookmarks, it adds a /DOCVIEW pdfmark to open the PDF with bookmarks visible.

While in general you probably want FrameMaker to generate all relevant pdfmark commands, there are 
situations where a pdfmark command generated by FrameMaker could create conflicts with your own 
pdfmark commands. 

IgnoreDOCINFO 
The /DOCINFO pdfmark – if present in the PostScript file being distilled – is used by Acrobat Distiller to 
create corresponding Document Info fields in the resulting PDF.

Acrobat 3 introduced the automatic (and uncontrollable) conversion of Document Structuring 
Conventions (DSC) comments to the appropriate Document Info fields. Such comments are written by 
the application which creates the PostScript file. Until FrameMaker 5.5.6, the Title comment was written 
but with no value, and the For comment was not written at all. If you did not define the appropriate 
/DOCINFO pdfmark, the Title, Subject, Author and Keywords fields were left empty.

However, if in FrameMaker releases earlier than 5.5.6, you included in your document EPS files which 
happened to have DSC comments, these were then inserted into the appropriate Document Info fields, 
resulting in meaningless or even embarrassing results.

FrameMaker 5.5.6 writes a Title comment (comprised of the filename) and a For comment (comprised of 
the registered user name). As these appear at the very beginning of the PostScript file, they are the 
dominant ones and will be used to set the corresponding Document Information fields. So if you happen 
to include EPS files and/or /DOCINFO pdfmark commands – these will not affect the Document Info fields 
which you will see in the PDF.

Note: If you use FrameMaker 6.0 and populate the DocInfo fields through the Document Info dialog box 
(PDF Setup, Document Information tab), make sure that IgnoreDOCINFO is turned off. 
The IgnoreDOCINFO setting can still be used to suppress FrameMaker 6.0’s DOCINFO, if required, 
for instance if you prefer to insert DocInfo fields using your own pdfmark commands.

If the /DOCINFO pdfmark is inserted in FrameMaker using a PostScript text frame or a PDFmarker, it is 
carried over to the PostScript file, so that the PDF you create already has what you need (and you don’t 
have to set these fields manually in Acrobat).

What happens if you have several pdfmark commands, possibly conflicting, in the same PostScript file? 
With some pdfmark commands, such as the /DOCVIEW pdfmark, the last command present in the 
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PostScript file is the one that is respected. With the /DOCINFO pdfmark, however, the first pdfmark 
command is the one that is respected, while the following commands are ignored.

FrameMaker issues a /DOCINFO pdfmark command to identify itself as the Creator Application, and this 
command is placed at the beginning of the PostScript file, before the description of your page contents. 
It will, therefore, be the first /DOCINFO pdfmark command and will cause the next /DOCINFO pdfmark 
command you insert to be ineffective.

The /IgnoreDOCINFO setting enables you to be in control of this situation. You can only set 
/IgnoreDOCINFO through the configuration files and TS-prolog.ini file. This is because the /DOCINFO 
command and/or DSC comments inserted by FrameMaker appear at the beginning of the PostScript file, 
and if you define /IgnoreDOCINFO using a PDFmarker, even if placed at the very beginning of your file, 
it will be processed after FrameMaker’s /DOCINFO command or DSC comments.

If /IgnoreDOCINFO is not activated (default), the FrameMaker definitions (if present) are respected.

If /IgnoreDOCINFO is set to 1, the /DOCINFO pdfmark command issued by FrameMaker is suppressed, 
causing your /DOCINFO pdfmark command (in PostScript text frames or a PDF marker) to be respected.

FrameMaker 5.5.6/6.0 on Macintosh only:

Only a /DOCINFO pdfmark inserted using a marker is respected. /DOCINFO pdfmark commands in 
PostScript text frames are not processed. 
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IgnoreDOCVIEW 
Results of using the IgnoreDOCVIEW function will vary, depending on the specific FrameMaker release 
you are using.

FrameMaker 5.5-5.5.3

When FrameMaker 5.5–5.5.3 creates bookmarks, it automatically writes a /DOCVIEW command at the end 
of the PostScript file to set the default view to display bookmarks (if created), overriding any /DOCVIEW 
command you include in the FrameMaker file to set the opening mode of the PDF file. This is because 
the /DOCVIEW command issued by FrameMaker is placed at the end of the PostScript print file, after your 
command. If you want bookmarks to be created, yet want the PDF file to be initially displayed in a 
different mode (with thumbnails, page only, full screen, and/or magnification) and so insert the 
appropriate /DOCVIEW command – you will not get the expected result.

FrameMaker 5.5.6-6.0

When outputting a single file to a PostScript file, FrameMaker 5.5.6 writes bookmarks and the 
accompanying /DOCVIEW command at the beginning of the PostScript file, and thus there is no conflict 
with a /DOCVIEW command that might be present in the FrameMaker file.

However, when using FrameMaker 5.5.6 and later to convert a FrameMaker book to a single PostScript 
file, the automatically-generated bookmarks are not written in the beginning of the PostScript file but 
prior to the last document in the book. This will create a conflict, unless your /DOCVIEW is placed in the 
last document in the book.

The solution: If /IgnoreDOCVIEW is activated, only /DOCVIEW commands you insert using a PDFmarker are 
respected, while /DOCVIEW commands issued by FrameMaker or placed by you in a PostScript text frame, 
in #included PostScript files or in the TS-epilog.ini file are ignored.

You can set the /IgnoreDOCVIEW through the configuration panel (or alternatively, through the 
TS-set.ini file), or by inserting a PDFmarker with the following command:
alert /Y /IgnoreDOCVIEW TSset
(in FrameMaker 5.5.6 and later, such a marker must be present in the first page of the document).
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IgnorePAGE 
The /PAGES pdfmark command sets page cropping for all pages in the document, whereas the /PAGE 
pdfmark command sets page cropping for the current page only. You can use the /PAGES pdfmark 
command to specify document-wide page cropping, and then using /PAGE pdfmark commands in 
specific pages will override the document-wide setting.

When you print a PostScript to a file using custom page sizes which are not part of the choices offered 
by your printer driver and Generate Acrobat Data is turned on, FrameMaker inserts a /PAGE pdfmark 
command at the beginning of each page to simulate the custom page size. This means that any /PAGES 
pdfmark command you insert will be overridden by the “specific” /PAGE pdfmark command inserted 
by FrameMaker.

To control page cropping your own way, FrameMaker’s /PAGE pdfmark commands have to be disabled. 
This can be done by activating /IgnorePAGE.

You can then insert a single /PAGES pdfmark command to control page cropping for all pages. 
Alternatively (or in addition), you can insert individual /PAGE pdfmark commands in specific pages.
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ConvertFMnewlink 
FrameMaker’s newlink hypertext marker is translated to a /DEST command in the PostScript print file, 
and is assigned a named destination with a prefix of M8.newlink. 

If a FrameMaker book is printed to a single PostScript file, the M8.newlink prefix is changed to 
M1.8.newlink for all newlink commands in the first file of the book, to M2.8.newlink for all newlink 
commands in the second file, etc. Corresponding gotolink commands (internal to a file, and cross-file 
within that book) are automatically adjusted accordingly. This is done to prevent a situation where valid 
identical newlink commands in different files become duplicates in the merged PostScript file.

The M8.newlink or Mn.8.newlink prefixes are of no significance as far as FrameMaker-generated links are 
concerned. However, if you need to define custom destinations so that specific locations in the PDF file 
can be the target of links in HTML files (or in external PDFs which are not part of your document 
collection), possible variations in the prefix cause the named destinations to be unreliable. The 
ConvertFMnewlink function was designed to overcome this problem.

When using ConvertFMnewlink, place a hypertext newlink marker with a destination name starting with 
TMS, followed by a single space and then the required destination name. This is automatically converted 
to a destination without any prefix. The horizontal and vertical locations of the marker are automatically 
registered as part of the destination. 

Alternatively, you can insert named destinations with the /DEST pdfmark – either using a PDFmarker, 
or through an anchored PostScript text frame. 

FrameMaker hypertext marker: Resulting destination:
newlink MainEntry M8.newlink.MainEntry

newlink TMS MainEntry MainEntry

newlink TMSMainEntry M8.newlink.TMSMainEntry

The ConvertFMnewlink option should not be used with destinations that are to be accessed by other 
FrameMaker hypertext markers.
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ManageArticle

When converting PostScript files generated by FrameMaker 5.0-5.1.2 (with Generate Acrobat Data 
turned on) to Acrobat, each tagged text flow that appears on a body page of a FrameMaker document 
becomes an article thread in the PDF file. 

FrameMaker 5.0-5.1.2 does not enable you to control article thread creation, which takes place 
automatically every time you create PostScript files with the Generate Acrobat Data option turned on. 
You can manually remove the article thread, after the PDF is created, using Acrobat. However, it will be 
present the next time the PDF is created.

In FrameMaker 5.5 and later, you can turn off the creation of Acrobat articles, or choose to create articles 
either from text frames or from columns (a must if you have multiple columns and want to have articles).

ManageArticle, once activated, can suppress the creation of article threads from “Flow A” text frames. 

Optionally, ManageArticle can convert each “Flow A” text frame into a separate article thread (with a 
name similar to the page number). This can be useful, for instance, in page-oriented catalogs where 
custom links can point to different articles (with several advantages compared to standard links). 

If ManageArticle is disabled, all articles will remain as created by FrameMaker (if created) – 
ConvertThreadA setting is ignored. 

If ManageArticle is enabled (and ConvertThreadA is disabled), all articles will be removed. 

If ManageArticle and ConvertThreadA are both activated, each “Flow A” text frame will be converted 
into a separate, single-bead article thread – with a name similar to the current page number.

The first page of each Acrobat document is page 1, regardless of the page number assigned in 
FrameMaker.
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UnBloat

FrameMaker 5.x writes an ObjectID named destination for each and every paragraph (regardless of 
whether a paragraph is an actual target of a link), so that links in generated lists (TOC, LOF etc.) will be 
valid. In FrameMaker 6.0, creating the destination for every paragraph is optional. As each named 
destination adds about 100 bytes to the file size, excessive named destinations can cause the PDF file 
to bloat. Actual bloating will be different for each document, depending on file contents and the 
number of destinations created. Typical jobs have a 25-30% increase in PDF file size; PDFs created from 
long, table-intensive FrameMaker documents might be 4 to 8 times larger than they should be!

The UnBloat option automatically removes all named destinations which are not actually used in the 
current PDF by links (or by bookmarks, in FrameMaker 5.5.6 and 6.0). 

In FrameMaker 5.5.6 there is a flag you can set in the header.ps file to minimize the number of named 
destinations. This change causes random bad links, and is not recommended. 

In FrameMaker 6.0, a new feature was implemented to reduce the number of generated named 
destinations. Compared with UnBloat, it is inefficient and unreliable, as many named destinations which 
are not used in the PDF(s) are left intact, while other destinations that are required by generated lists or 
external cross-references are not present in the PS/PDF (unless the specific paragraphs happen to be 
used by bookmarks, cross references or hypertext markers).

When distilling with UnBloat activated, distilling time increases. As with large publications, hundreds of 
thousands of ObjectID named destinations need to be checked to determine their status. Depending on 
your processor speed and actual files, the time difference may be noticeable.

To show progress during the inspection phase, following the “UnBloat activated, please wait…” 
message, a dot is printed each time 10000 objectID named destinations are processed. (You can change 
this value by setting the UnBloatProgressIndicator entry in the TS-set.ini file; no corresponding value 
in the Configuration Panel).

Automatically-generated ObjectID destinations are in the format of “G” (for paragraphs) followed by 
at least 4 digits, such as G99674. 

When generating PostScript files for a book, these named destinations will have the form of Gn.99674, 
where n indicates the position of the chapter in the book file.

Prior to using UnBloat, verify that:

• PostScript files are produced with the ‘Optimize for Speed’ printer driver option turned on.

• FrameMaker uses the original header.ps (if you modified the header to reduce the number of named 
destinations, revert to the default version).

• (FrameMaker 6.0 only) “Create Named Destinations for All Paragraphs” must be turned on 
(PDF Setup, Links tab).
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UnBloat cannot check whether a specific named destination in the current file is being used as the 
target of links in generated lists, if they are separately converted to PDF. However, if you convert your 
FrameMaker books (including generated lists, if part of your book) to single PDFs, interactive features – 
bookmarks, internal and external links (cross-references or hypertext) – will not be affected by the 
UnBloat option. 

If you convert a FrameMaker book to multiple PDFs and UnBloat is active, links in generated lists will be 
damaged – unless the destinations for links are paragraphs specified as bookmarks (in FrameMaker 5.5.6 
and later), or used as the source of internal cross-references.

DeleteRedundantMarkers 
Note: If your FrameMaker books include generated indexes, use the DeleteRedundantMarkers option 
only if you are converting a FrameMaker book to a single PDF file.

In addition to writing destinations for all paragraphs, FrameMaker writes an ObjectID destination for 
each marker inserted, independently of the marker type and regardless of whether the marker is used 
by links in generated indexes. If UnBloat is active, DeleteRedundantMarkers enables you to minimize 
destinations for markers as well: only destinations for markers actually used in the current PDF will be 
retained. 

Regardless of whether you use UnBloat or not, it is recommended to systematically check validity of all 
interactive features (links, bookmarks, form fields and page actions) in all PDFs you create, using link 
checking utilities such as Ari’s Link Checker (from Dionis, http://www.dionis.com).

http://www.dionis.com


© 2001 MicroType

SP TimeSavers, FrameMaker Edition • UnBloat 50

LinkReporter
LinkReporter is a built-in component of SP TimeSavers, which generates a report of all Acrobat Distiller 
parameters in effect and a listing of FrameMaker-originated Acrobat commands (type, location and link 
details) – for each distilled PostScript file.

This report is useful for troubleshooting and quality assurance purposes. Saving the report of the 
previous PDF version and running a comparison utility against the new report could tell you if, what and 
where Acrobat features were changed. 

The report is stored as a text file with the name of temp_lnkrpt.txt in the Distiller/TimeSavers directory 
and you can view it using any text editor. 

A log file is created by Acrobat Distiller in the same folder where you create the PDF file (same name of 
the PDF file, with the .log extension). All messages sent to the Distiller Window by the TimeSavers are 
recorded there, including information about options that are activated. This file is also overwritten every 
time you distill the same PostScript file.

Each time you distill a PostScript file, temp_lnkrpt.txt is overwritten. Therefore, if you need to keep a 
report file in order to compare it with later versions, rename the report file before distilling any other 
file.
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